# Table of Contents

## Introduction
- Welcome to DxO ViewPoint 3 ................................................................. 1
- New features in DxO ViewPoint 3 .......................................................... 3
- Versions and system requirements ...................................................... 4
- Registration, downloading, installation and activation ....................... 6
- Supported file formats ......................................................................... 9
- Workflow with host application .......................................................... 10

## The DxO ViewPoint 3 workspace
- The interface ....................................................................................... 11
- The image browser ............................................................................... 12
- Toolbars ............................................................................................. 14
- Palettes ............................................................................................... 16
- Warning messages .............................................................................. 19

## Correcting distortion
- About distortion .................................................................................. 21
- Managing DxO Optics Modules ......................................................... 22
- Correcting distortion .......................................................................... 24

## Correcting volume deformation
- About volume deformation ................................................................. 28
- Determining the type of volume deformation ....................................... 29
- Correcting volume deformation .......................................................... 30

## Fixing perspective
- About perspective .............................................................................. 31
- Automatic perspective correction ...................................................... 34
- Forcing vertical parallels ................................................................... 35
- Forcing horizontal parallels .............................................................. 36
- Forcing a rectangle .............................................................................. 39
- Correcting perspectives in 8-point mode ........................................... 41
- Advanced settings ............................................................................ 43

## Straightening the horizon
- About horizons .................................................................................. 45
- Straightening the horizon automatically ............................................ 46
- Straightening the horizon manually .................................................. 47

## Cropping
- Cropping an image ............................................................................ 48

## Miniature effect
- About the miniature effect ............................................................... 49
- Applying a miniature effect ............................................................... 51

## Menus and preferences
- ............................................................... 52

## Keyboard shortcuts
- ............................................................... 53
Introduction

Welcome to DxO ViewPoint 3

Thank you for choosing DxO ViewPoint, the first software solution for Mac and Windows entirely dedicated to correcting lens distortions and deformed elements on the edges of photos, to redressing problems with perspective and tilted horizons, and to applying miniature effects.

Based on DxO's exclusive lens and geometric correction technologies, DxO ViewPoint lets you easily and efficiently restore the natural proportions of the subjects in your images.
Introduction

New features in DxO ViewPoint 3

Automatic perspective correction

Automatically correct vertical lines, horizontal lines, or both together. In addition, if you move into manual mode, the automatic changes are preserved and integrated so as to serve as the basis for further work.

Automatic horizon straightening

DxO ViewPoint 3 automatically straightens out a tilted horizon without intervention on your part.

Miniature effect

The miniature effect lets you give your landscape or cityscape the look of a model, or to attract the viewer's attention to a particular point within the image.

Image browser (standalone mode only)

The image browser displays the contents of a folder of photos in the form of thumbnails. You can also display recent files.

New interface

The new interface has been optimized so as to allow you to concentrate on the image and on tool use.
Introduction

Versions and system requirements

DxO ViewPoint 3 versions

DxO ViewPoint 3 comes in two versions:

- As a standalone application, DxO ViewPoint 3 is autonomous. It applies its corrections to the images, which then can be integrated into a host application for further processing (see below for supported image file formats).

- As a plugin, DxO ViewPoint 3 can be used with five applications:
  - DxO PhotoLab
  - DxO OpticsPro 11
  - Adobe® Photoshop® Elements® 9, 10, 11, 12, 13, 14, 15, 2018, 2019, 2020
  - Adobe® Photoshop® Lightroom® 3, 4, 5 & 6, Classis CC

DxO ViewPoint 3 can be installed simultaneously as a standalone application or as a plugin on your computer, so you can use either version whenever you want.

Even though DxO ViewPoint 3 still supports Aperture 3, Apple no longer sells this product.

As a plugin for DxO PhotoLab, DxO ViewPoint 3 is fully integrated into the DxO PhotoLab workflow and appears as a dedicated palette in the Customize tab. This version offers the most comfortable way to work as well as the best performance, as it lets you correct your images within a totally reversible RAW workflow.

If an image has been previously opened in one of these applications, you can temporarily transfer the image into DxO ViewPoint. You can process the image in DxO ViewPoint 3 and then transfer it back into the other application.

System requirements

For the best results with DxO ViewPoint, your computer must conform to the following minimum specifications:

Microsoft Windows

- Intel Core® 2 Duo, AMD Athlon™ 64 X2 or higher.
- 4 GB of RAM (8 GB recommended)
- 400 MB of available disk space
- Microsoft® Windows® 8.1 (64 bits), Microsoft® Windows® 10 (64 bits)
- Screen resolution 1024x768 or larger

**OS X / macOS**

- Intel Core™ i5 or higher
- 4 GB of RAM (6 Go recommended)
- 400 MB of available disk space
- macOS 10.13 (High Sierra), 10.14 (Mojave), 10.15 (Catalina)
- Screen resolution 1024x768 or larger

ℹ️ To process large image files, a 64-bit system and 8 GB of RAM are recommended.
Introduction

Registration, downloading, installation and activation

⚠️ An Internet connection is required to follow the steps described below.

Registration

You need to register your license in order to activate your software. To do so, go to the DxO website at https://www.dxo.com/cd and follow the registration procedure. If you do not have a customer account, fill out the new customer form. If you already have a customer account, log in.

Downloading

Once you have registered your license, you will find important information in your customer account about the software, along with the download link for DxO ViewPoint 3. This procedure ensures that you will be installing the latest version of the software. Click on either the WIN or MAC button (depending on your equipment) to begin downloading the installer.

After the download is completed, double-click on the installation program icon that you just downloaded and follow the specified installation procedure.

Installing

There are several options for installing DxO ViewPoint:

- Standalone application for Microsoft® Windows and Macintosh
- Plugin for Adobe® Photoshop®
- Plugin for Adobe® Photoshop® Elements®
- Plugin for Adobe® Photoshop® Lightroom®
- Plugin for Apple® Aperture®

ℹ️ A single license allows you to install and run DxO ViewPoint on four separate computers.

Microsoft Windows

1. After accepting the license agreement, click on Next.
2. You can select between Standard and Custom installation. The standard installation will automatically install all relevant plugins. Custom installation allows you to choose which plugin(s) to install.
3. A new window will open asking you to choose the folder in which you want to install DxO ViewPoint. If
the program does not automatically detect the directory in which to install the Adobe® Photoshop® plugin, you can select the appropriate folder by using the Browse button.

4. Click the Install button. The installation starts and may take several minutes.

![Microsoft Windows installation window.](image)

**OS X / macOS**

1. After accepting the license agreement, click on Next.

2. A window will open that allows you to select the component(s) you want to install.

3. A new window will open asking you to choose the folder in which you want to install DxO ViewPoint. If the program does not automatically detect the directory in which to install the Adobe® Photoshop® plugin, you can select the appropriate folder by using the Browse button.

4. Click the Install button. The installation starts and may take several minutes.

**Activation**

1. Launch DxO ViewPoint 3.

2. A dialog box will appear. Enter (or cut and paste) your activation code in the appropriate field and click on the Activate button.

3. If you have not created your account, a message appears asking you to visit the page to create an account at the following link: www.dxo.com. Fill out the form and submit it. A message will tell you when your account has been created and your activation code will appear in your customer account. Return to the application and enter your activation code.
4. A message will inform you that DxO ViewPoint 3 has been properly activated. Click on OK. You can now start using your software.

To activate DxO ViewPoint for Microsoft® Windows Vista®, Windows 7 or Windows 8, you must open a session as an administrator. Further, if you are using Windows Vista® and the User Accounts Control is activated, you must launch DxO ViewPoint as an administrator. To do so, right-click on the DxO ViewPoint shortcut icon on the Windows desktop and select “Execute as an administrator.” You only have to do this once.

Uninstalling

Microsoft Windows

1. Click on Start > Programs > DxO ViewPoint 3 > Uninstall DxO ViewPoint 3
2. Follow the procedure for uninstalling.

OS X / macOS

1. Click on Applications > DxO ViewPoint 3 > Uninstall
2. Follow the procedure for uninstalling.
Introduction

Supported file formats

DxO ViewPoint 3 processes JPEG and 8- or 16- bit TIFF files up to 200 Megapixels in RGB. Grayscale files are also supported.
Workflow with host application

DxO ViewPoint readily integrates with the workflow of photographers who use Adobe solutions. Used as a plugin for Adobe® Photoshop®, Adobe® Photoshop® Lightroom®, or Adobe® Photoshop® Elements®, or as a plugin for Apple® Aperture®, the application is called directly by the host software from an image that is already open.

Launching the plugin for Adobe Photoshop Lightroom

To correct an image with DxO ViewPoint while working in Adobe Photoshop Lightroom:

- Launch the plugin version of the application from the Photo > Edit in > Edit in DxO ViewPoint menu.

You can also right-click on the image that you want to correct and select the command Edit in > Edit in DxO ViewPoint 3.

- A dialog box will open showing the option Edit a Copy with Lightroom Adjustments. This option will allow you to use DxO ViewPoint to touch up images previously corrected in Adobe Photoshop Lightroom.

- Choose the file export format — JPEG or TIFF in 8-bit or 16-bit (16-bit images have higher quality, but the files are much larger). Generally, you should keep the resolution at its actual value, and the compression option should be “None.”

- Click on the Edit button to launch DxO ViewPoint.
Dialogue box and plugin options for Adobe® Photoshop® Lightroom®.

Launching the plugin for Adobe Photoshop

To correct an image in DxO ViewPoint while working with Adobe® Photoshop®, launch the application from the Filters > DxO Labs > DxO ViewPoint 3 menu.

Launching the plugin for Adobe Photoshop Elements

To correct an image in DxO ViewPoint while working with Adobe Photoshop Elements, launch the application from the Filters > DxO Labs > DxO ViewPoint 3 menu.

Launching the plugin for Apple Aperture

To correct an image in DxO ViewPoint while working with Apple Aperture,
- Launch the application from the Photos > Edit with > DxO ViewPoint 3.
- You can also right-click on the image and select Edit with a plugin > DxO ViewPoint 3 from the contextual menu.
The DxO ViewPoint 3 workspace

The interface

The DxO ViewPoint 3 user interface is composed of 5 main parts:

1. The upper toolbar
2. The image display and file depot
3. The lower toolbar
4. The Correction palette
5. The magnifying glass

In standalone mode, DxO ViewPoint 3 has an image browser composed of the following parts:
1. Thumbnail display area
2. The file browser
3. Lateral toolbar for viewing recent images
4. Image sorting
5. Defining thumbnail size
The DxO ViewPoint 3 workspace

The image browser

The image browser is available only in the standalone version of DxO ViewPoint 3. It lets you display the contents of an image folder as well as recently-opened images.

When you open DxO ViewPoint 3 for the first time, the image browser will display the sample photos included with the application.

![A sample photo directory as displayed by the new image browser.](image)

The image browser is organized as follows:

1. Source browser (sidebar)
   - Image browser: Displays the contents of the selected folder in the upper toolbar.
   - Recent images: Displays the images that you have recently opened and/or processed.

2. Upper toolbar:
   - Open: Opens a system dialogue box in which you can choose and display the image contents of a folder.
   - File pathway: Indicates the file pathway of the selected folder.
   - Sort: Lets you display images according to certain criteria (such as shooting date, last change date,
alphabetical order, file type), and to sort them in ascending or descending order.

- Thumbnail size: Use the slider to increase or diminish the size of the thumbnails.

3. Image display area

The image display area displays the contents of a folder as thumbnails:

- Click on its thumbnail to select an image.

- Double-click or press Enter (Windows), or simply press Enter (Mac) to open an image in the correction section.
The DxO ViewPoint 3 workspace

Toolbars

The upper toolbar

Located at the top of the DxO ViewPoint window, the upper toolbar includes tools for opening and saving files, as well as for different display modes and navigation.

1. File management
   - Open*: Opens a dialog box so you can select an image to correct from the system files or directories in which you store your photos.
   - Save As*: Opens a system dialog box so you can save the image you correct and process in DxO ViewPoint.

2. Display modes:
   - Display before/after images side-by-side: Display initial and corrected images side-by-side, with the uncorrected image on the left, and the corrected on the right.
   - Toggle between before/after images: Display before/after images one after the other; left-click with the mouse to toggle between before and after views.

   You can also alternate between before and after versions of the image by pressing the D key.

3. Display size:
   - Fit to screen: Adjusts the image size so the entire image fits the application display screen.
   - Display at 100%: The image is enlarged to 100% (1 image pixel = 1 screen pixel).

To zoom within the image, use the mouse wheel, and navigate with the Hand tool (which replaces the mouse pointer).
4. Tools
- Compare with original image: Lets you quickly compare between a corrected version and the original version when you press and then release the button.
- Display/Hide grid overlay: This button activates/deactivates the superimposition of the composition grid on an image.

5. Rotation tools
- Rotation tools for pivoting the image to the left or to the right.

6. Navigation between images
- Lets you navigate among the images in the same directory, or among recent images: Left arrow, the preceding image; right arrow, the following image. The central button lets you return to the image browser or to the display of recent images.

7. Full-screen display
- Full screen (Windows): Click on this button to use the entirety of your screen when working in DxO ViewPoint. To return to the regular display, click on the button again.

You can also go into full-screen mode in OS X / macOS by clicking on the third button, in the upper left of the window.

The lower toolbar

Perspective tool

1. Tool selected: This icon serves as a reminder of the tool you are currently using.
2. Line color: Clicking on the small blue (default color) square opens a color picker that allows you to choose the color of your perspective and horizon correction lines so as to optimize their visibility on the image you are correcting. (Note: This command is not available with the Crop tool. Also note that the application remembers the last line color you choose.)
3. Display grid: Available only with the Crop tool, this checkbox activates or deactivates the superimposition of the composition grid on the image.

Crop tool

This toolbar is displayed at the bottom of the application window, and depending on the correction tool selected and activated in the palettes, can include the following commands (from left to right):

1. Tool selected: This icon serves as a reminder of the tool you are currently using.
2. Line color: Clicking on the small blue (default color) square opens a color picker that allows you to choose the color of your perspective and horizon correction lines so as to optimize their visibility on the image you are correcting. (Note: This command is not available with the Crop tool. Also note that the application remembers the last line color you choose.)
3. Display grid: Available only with the Crop tool, this checkbox activates or deactivates the superimposition of the composition grid on the image.
4. Opacity mask: Available only with the Crop tool, this slider brightens or darkens the parts the image that are outside the crop area.

5. Preview: Available only with the Perspective and Horizon tools, this tool lets you refresh the content of the image after you have applied your corrections.

6. Reset: Undoes all unsaved corrections and returns to the original image.

7. Apply: Applies the corrections and then closes the lower toolbar. To reopen the lower toolbar, click on a tool icon in one of the correction palettes.

The second lower toolbar (plugin version)

In the plugin version of DxO ViewPoint, a second toolbar is located on the bottom of the window and contains the following commands (from left to right):

1. Preferences: Opens the dialog box to adjust the application settings.

2. Help: Accesses DxO ViewPoint online help (Internet connection required).

3. Cancel: Allows you to quit from DxO ViewPoint, but first, a dialogue box will ask you if you want to save your changes or not. If you click on Cancel within the dialog box, it will close the dialog box and return you to the DxO ViewPoint interface.

4. Save: Definitively applies the corrections and then quits from the plugin before returning to the host application.
The DxO ViewPoint 3 workspace

Palettes

Correction tool palettes

The different correction tools – Distortion, Volume deformation, Perspective, Horizon, Crop, and Miniature effect – are explained in greater detail in their respective sections in this guide. Below are brief descriptions of the general features of the palettes and of the commands that all palettes have in common.

General information

1. Reset all corrections: This feature lets you cancel all corrections and return to the initial image you started with. See "Resetting corrections" below.

2. Deploy or hide palette: Each palette contains a certain number of tools and setting sliders. To deploy or to hide them, click on the arrow icon in the bottom right corner of the relevant section.
3. Activate / deactivate palette: This button indicates the palette’s functional status: to the left and gray, deactivated; to the right and blue, active. Click on the button to activate or temporarily deactivate the palette and its correction toolset.

4. Hide tools: While the contents of a palette is displayed (that is, the additional tools and sliders), you can click on the “−” sign in the bottom right of each palette to return to the regular palette view.

5. Reset correction: Each tool has a reset button.

6. Display or retract palettes: Click to hide or open up the lateral panel.

The Visualization palette no longer exists in DxO ViewPoint 3; it has been replaced by a magnifying glass attached to the lines for correcting perspective and horizon.
The DxO ViewPoint 3 workspace

Warning messages

Warning messages tied to EXIF data or to DxO Optics Modules can appear in the DxO ViewPoint Distortion, Volume deformation, and Perspective palettes.

Warning message in the Distortion palette.

Distortion palette

- EXIF data: In plugin mode, if EXIF data is not available, DxO ViewPoint will retrieve the information from the original file. If that is not possible, then automatic distortion correction cannot be performed, although manual correction is still possible.

- DxO Optics Modules: Different messages address ambiguity (i.e., several different DxO Optics Modules are available for the same equipment), and the availability of and updates to Optics Modules. If there are no DxO Optics Modules available, then automatic correction cannot be performed, although manual correction is still possible.

Perspective/Volume deformation palettes

If EXIF data is missing, then automatic correction will not occur. The message will suggest manually adjusting the H/V Ratio slider to modify the image proportions or the intensity.
Correcting distortion

About distortion

All lenses are more or less affected by distortion, which takes two principal forms:

- **Barrel**: Lines are curved toward the exterior of the image.
- **Pincushion**: Lines are curved toward the interior of the image.
The two principal types of distortion: pincushion (left) and barrel (right)

Some lenses are affected by both phenomena — for example, a zoom lens can display a barrel distortion at its shortest focal length, and a pincushion distortion at its longest focal length... not counting all the distortion variations at intermediate focal lengths.

DxO ViewPoint uses DxO Optics Module distortion corrections; to avoid a double correction, we advise you not to use the lens correction features in your host application.

DxO ViewPoint lets you correct distortion for every kind of lens, either automatically for camera/lens combinations supported by DxO Optics Modules, or manually if the camera/lens combination you use is not yet supported by a DxO Optics Module.

DxO ViewPoint also corrects automatically or manually the circular distortion seen in images taken with fisheye lenses.
Correcting distortion

Managing DxO Optics Modules

Downloading and installing DxO Optics Modules

When you choose automatic distortion correction, a dialogue box about managing DxO Optics Modules will open. This dialogue box indicates which DxO Optics Module(s) can be used, allows you to choose among the appropriate DxO Optics Modules available if there is any ambiguity — that is, if DxO ViewPoint cannot fully identify the camera/lens combination you used to take the shot.

![DxO Optical Module Selection](image)

The same dialogue box also displays the status of the appropriate available DxO Optics Modules — “Installed,” “Update available,” or “Download.”

1. Select the DxO Optics Module you want to use and then click on OK.

2. If you are downloading an updated version or a new module, you will see a progress bar. As soon as the download is finished, the installation will be immediately effected and taken into account. You will not need to restart the application.
If a DxO Optics Module is not available

If no DxO Optics Module is available for your equipment, the automatic correction will not be applied, and the Automatic button is deactivated. In this case, you can manually correct your image.

You can eliminate the DxO Optics Module you are using for processing an image by clicking on the trash can icon located in the upper right of the Distortion palette.
Correcting distortion

Correcting distortion automatically

If your material is supported by a DxO Optics Module, you can correct your image automatically.

![Distortion palette, automatic correction](image)

1. Open an image in DxO ViewPoint by selecting File > Open, or drag and drop your image into the application window.

2. In the Distortion palette, click on the Automatic with DxO Optics Module button.

3. A dialogue box will indicate if a DxO Optics Module for your equipment is already installed, or if not, whether it is available for downloading.

4. Click on OK to correct the image using the selected DxO Optics Module and to close the dialogue box.

When a DxO Optics Module is installed and taken into account, the Distortion palette displays the following information: camera model used, lens model used, and the name of the original image file.

Applying an automatic distortion if DxO ViewPoint does not find the necessary EXIF metadata information

If DxO ViewPoint does not find the necessary EXIF metadata information, a dialogue box will offer to find the original image in order to retrieve the missing information. This said, certain programs modify and sometimes eliminate the EXIF data necessary for DxO ViewPoint to determine the proper DxO Optics Module to use (this is the case with Adobe Photoshop Lightroom and Apple Aperture).
1. Open your image in DxO ViewPoint.

2. If a dialogue box in the Distortion palette requests access to the original file, click on Open original image.

3. To find the original image, click on Open in the system dialogue box that appears at the top of DxO ViewPoint. You will need to find the JPEG or RAW image file that was loaded directly from your camera before processing.

4. After finding and selecting the original image, validate by clicking on Open. If the corresponding DxO Optics Module is not already installed, a new dialogue box will open and prompt you to download it (if available); otherwise it will display the information about the shooting equipment and the name of the original file.

5. After you have applied your corrections, click on the Save button on the lower right. DxO ViewPoint will close and the corrected file will be transferred back to the host application.

Correcting distortion manually

If your shooting equipment is not supported by a DxO Optics Module, you can manually correct your image.

1. Open an image in DxO ViewPoint by selecting File > Open, or drag and drop your image into the application window.

2. In the Distortion palette, click on the Manual button.
3. Depending on the type of distortion visible in the image, select either Barrel, Pincushion, or Fisheye. The correction will be applied immediately.

4. If necessary, you can use the Intensity slider to fine-tune the correction.
Correcting volume deformation

About volume deformation

The deformation of subjects located on the edges of images is a geometrical flaw that is frequently seen in interior, marriage, and other event photos.

Known as "volume deformation," this flaw is due to taking pictures of groups of people or objects with a wide-angle or wide-angle zoom lens. The curve of the lens stretches out and distorts the subjects on the image edges.

For optimal quality results, we advise you to correct any problems with distortion before correcting volume deformation.
Correcting volume deformation

Determining the type of volume deformation

Look carefully at your image to determine the kind of distortion affecting it:

If the spherical objects (such as heads) near the edges of your image appear stretched or flattened, your image is suffering from a cylindrical or horizontal/vertical volume deformation, in which case you need to use the horizontal/vertical correction tool.
If objects seem to stretch toward the corners of the image, then you are dealing with diagonal volume deformation, in which case you will need to use the diagonal correction tool.
Correcting volume deformation

Correcting horizontal/vertical volume deformation

1. After opening your image in DxO ViewPoint, activate the horizontal or vertical volume deformation correction by clicking on the Horizontal/Vertical button in the Volume deformation palette.

2. The correction is automatically applied to the image.

The settings can be adjusted by using the sliders.

- The Horizontal slider can stretch the image content toward the edges of the photo (slider moved to the left) or can compress the objects toward the center (slider moved to the right). Its default value is 100 (slider at center).
- The Vertical slider flattens the image content vertically. Its default value is 0 (slider on the left).

Correcting diagonal volume deformation

1. After opening your image in DxO ViewPoint, activate the diagonal volume deformation correction by clicking on the Diagonal button in the Volume deformation palette.

2. The automatic correction is immediately applied to the image.

When in doubt, don’t hesitate to experiment with both tools, and then choose the one that makes the subjects in your image appear the most natural. Keep in mind that you can fine-tune the
automatic correction by using the sliders in the Volume deformation palette.

If necessary, you can manually fine-tune the correction by adjusting the Intensity slider. Moving the slider to the left, the image will be progressively stretched and distorted toward the center; moving to the right, the image is stretched and distorted toward the edges. The default setting for this slider is 150.

Double-click on any slider to return it to its default value setting.

Correcting volume deformation can clip the total surface area of the image. If you think you will need to apply this correction, give a larger frame to your photo when shooting.

You can fine-tune the value settings of your corrections by entering a value in the bubble displayed above the slider when it is in use.

You can better see the changes effected by the volume deformation correction if you display the composition grid, which serves as a visual reference.
Fixing perspective

About perspective

In architectural photography, the position of the photographer relative to a building almost always means a low-angle or high-angle shot. In both cases, convergent lines distort the subject, and the distortion becomes even more pronounced toward the edges of the image.

DxO ViewPoint offers tools for correcting vertical and horizontal parallel lines, for forcing a rectangle (to straighten out, for example, window and door frames), as well as an 8-point correction mode that allows you to correct each side completely independently.
Fixing perspective

Automatic perspective correction

DxO ViewPoint 3 lets you automatically correct perspectives as well as to manually adjust the corrections (if necessary). Any automatic corrections are preserved if you then decide to go into one of the manual modes (Forcing [vertical/horizontal] parallels, Rectangle, and 8 points).

After you open your image in DxO ViewPoint 3, go into the Perspectives palette and click on the Auto button. By default, DxO ViewPoint 3 will automatically correct both vertical and horizontal perspectives. If you are not satisfied with the result, you can select one of two different modes within the Auto correction palette, Verticals only or Horizontals only; the correction will be applied as soon as you select it in the drop-down menu.

You can use the Intensity slider to adjust the automatic correction, or you can use the advanced settings to modify the perspective (see the Advanced settings section).

To reset the automatic perspective correction, click on the cancel icon in the upper right side of the palette.

Correcting perspectives can result in heavy cropping, so be sure to take that into account and include sufficiently large margins when framing your photos.

Before correcting perspectives automatically, first correct any distortion in order to achieve optimal results.
Fixing perspective

Forcing vertical parallels

1. After opening your image in DxO ViewPoint, go to the Perspective palette and then click on the Force Vertical Parallel button. Two vertical lines, each one with two circular anchor points, will be superimposed on your image.

2. Choose two vertical reference elements in your image, preferably located on the same plane, for optimal correction.
Choose your vertical reference elements and place the correction lines.

3. Place the mouse cursor on one of the anchor points and click on it: a magnifying glass will automatically appear to help you place the anchor points with greater precision. Move the anchor point to one of the ends of your reference element. An active anchor point is indicated by a dark gray circle.

[i] Press the Shift key to slow down the movement of the anchor point so that you can increase the precision of its placement.

4. Place the second anchor point so as it aligns with your vertical element. Follow the same procedure for the second line. You can also use your keyboard’s 4 arrow keys to place the anchor points with even greater precision. Once aligned, it is also possible to reposition the lines by clicking on their center with the mouse.

[i] Pressing the Tab key lets you switch from one anchor point to another.

5. DxO ViewPoint lets you verify your correction settings before applying them to your image. To do so, click on the Preview button in the lower toolbar. DxO ViewPoint will correct your image and will darken the parts of the image that will be suppressed when the automatic crop is applied (see Cropping). The greater the correction, the more the image will be cropped to compensate for rectifying the low- or high-angle shot.

The darkened zones indicate the parts of the image that will disappear when cropped.

6. Click on the Apply button in the lower toolbar.
So long as the corrected image has not been saved, the changes can be undone and can be reset by clicking on the Reset the correction button.

You can change the color of the lines to improve their visibility with respect to the background color of your image. Click on the colored Line color block located in the lower toolbar and select the color you want to use.

Correcting volume deformation can clip the total surface area of the image. If you think you will need to apply this correction, give a larger frame to your photo when shooting.
The principle for forcing horizontal parallels is identical to that for forcing vertical parallels, except that the reference lines are horizontal and will let you align and level, for example, the top and bottom of a building, a window frame, or a door.

1. To activate the correction for horizontal perspectives, click on the Force Horizontal Parallel button in the Perspective palette. Two horizontal lines with two circular anchor points will be superimposed on your image.

2. Choose two horizontal reference elements in your image and place your lines in the same way as for correcting vertical perspectives.
3. Place the mouse arrow on one of the anchor points and click on it to grab it and move it to one of the ends of your reference element. Move the second anchor point so as to align the line with your horizontal element. Proceed in the same way for the second line.

4. Verify your correction by clicking on the Preview button in the lower toolbar. DxO ViewPoint 3 will darken the parts of the image that will be suppressed when the automatic cropping is applied.

5. Click on the Apply button in the lower toolbar.

**The magnifying glass integrated with the anchor points, using the Shift key to slow down placement movement, and switching from one anchor point to another using the Tab key also work for Forcing a rectangle and Correcting perspectives in 8-point mode.**
A third function of the perspective correction feature lets you use a reference rectangle to simultaneously correct both vertical and horizontal perspectives independently on each side. The applications are numerous: you can restore the exact shapes and forms to distorted elements in the scene, or straighten an interior space (such as an airport arrivals hall, a museum, or palace gallery) that was not shot in perfect alignment with an axis, or was taken at a too-low or too-high angle, etc.

1. To activate the correction, click on the Rectangle button.

2. You can act on all four lines: place the anchor points on the axes of the vertical and horizontal reference lines (which should be on the same plane as much as possible — that is, on elements located at approximately the same shooting distance).
Each anchor point acts on two lines at the same time.

3. Verify your correction by clicking on the Preview button in the lower toolbar. DxO ViewPoint will darken the parts of the image that will be suppressed when the automatic cropping is applied.

4. Click on the Apply button in the lower toolbar.

The magnifying glass integrated with the anchor points, using the Shift key to slow down placement movement, and switching from one anchor point to another using the Tab key also work for Forcing horizontal parallels and Correcting perspectives in 8-point mode.

Manipulating one anchor point circle in the Rectangle tool affects both a vertical and a horizontal line.

Clicking on Ctrl/Cmd while moving an anchor point will cause the correction to take effect in real time without having to click on the Preview button.

You can display the composition grid to verify that all the principal elements in your image have been correctly adjusted according to your settings, instead of relying solely on a naked-eye assessment.
Fixing perspective

Correcting perspectives in 8-point mode

The 8-point perspective correction follows the same principle as forcing a rectangle, with one important difference: while forcing a rectangle lets you adjust the four sides independently, the lines need to be placed on the same plane in order to achieve an optimal result.

With the 8-point method, you can place the lines on different planes, which gives you great flexibility when making complex corrections, or when the elements that need to be fixed are not all at the same distance from the where the photo was shot.

1. To activate the correction, click on the 8 points button.

2. You can act on each of four lines in a completely independent way: you can place them on the vertical and horizontal reference lines in the image, even if they are not on the same plane — that is, even if they are at different distances from the shooting point. The lines should be located as far away as possible from each other.
Choosing horizontal and vertical reference elements and placing correction lines.

3. Verify your correction by clicking on the Preview button in the lower toolbar. DxO ViewPoint will darken the parts of the image that will be suppressed when the automatic cropping is applied.

4. Click on the Apply button in the lower toolbar.

The magnifying glass integrated with the anchor points, using the Shift key to slow down placement movement, and switching from one anchor point to another using the Tab key also work for Forcing horizontal parallels and Forcing a rectangle.
Fixing perspective

Advanced settings

The Perspective palette provides four sliders for fine-tuning correction settings:

Intensity: This cursor, with a default value of 100, helps you find the best compromise between possible corrections and the most natural rendering. The Intensity slider lets you adjust the perspective correction to achieve the most natural look.

To simplify the interface, the Complete and Natural buttons in preceding versions of DxO ViewPoint have been removed.

You can fine-tune how natural the perspective correction looks by, for example, setting the Intensity slider to 75 instead of 100. (Of course, the setting will depend on the subject and on the type of rendering you would like).
Full vs. Natural perspective correction.

Up/Down: Toggles the image around a horizontal axis. This command can be used if the image has few reference lines, and also to compensate as much as possible for a shot that was not perfectly in line with the subject.

Left/Right: Toggles the image around a vertical axis.

H/V Ratio: This slider lets you fix distortions that can sometimes accompany perspective corrections. The default value is 0. Moved to the left, the image is compressed vertically; moved to the right, the image is compressed horizontally.

*Effect of the H/V Ratio slider.*

With respect to the Perspective palette, see [Warning Messages](#) for more information concerning messages about missing EXIF data making impossible the automatic correction of the image aspect ratio.
Straightening the horizon

About horizons

A common flaw in landscape photography: the horizon is tilted by several degrees, or vertical elements such as poles or trees appear slanted. In all instances, tilting occurs most often because the photographer does not hold the camera absolutely level. The solution to this problem is simple: adjust the entire image by several degrees.
Straightening the horizon

Straightening the horizon automatically

To straighten the horizon automatically, go to the Horizon palette and click on the Auto button.

To optimize the calculations for automatically straightening the horizon, first correct the distortion, which can — depending on the camera and/or lens that you may use — significantly curve the horizon line.

![Image of horizon correction before and after]

If you are not satisfied with the result, you can:

- Use the Angle slider to adjust the correction, either by moving the slider or by entering a value in the bubble that displays about the slider.
- Use the manual straightening tool.
Straightening the horizon

Straightening the horizon manually

The Horizon tool

Before straightening the horizon, correct the distortion, which — depending on the camera and/or lens you use — can significantly curve the horizon line.

The Horizon tool lets you correct compositions with a tilted horizon line. This feature can be used in tandem with the Perspective tool.

1. To activate the tool, click on the Horizontal Level or Vertical Level button in the Horizon palette.

2. A horizontal or vertical line with two circular anchor points will be superimposed on your image.

3. Place the mouse cursor on one of the anchor points. Click on the anchor point to grab and move it to one of the ends of your reference element. Move the second anchor point to align with the line on your horizontal or vertical element.

4. When you click on an anchor point, the magnifying glass automatically displays so that you can use it to more precisely place the anchor point.

To slow down the movement of the magnifying glass, hold down the Shift key. You can also use your keyboard’s arrow keys to move an anchor point. The Tab key lets you switch from one anchor point to another.
Choice of horizontal reference element and placement of the correction line.

5. Verify your correction by clicking on the Preview button in the lower toolbar. DxO ViewPoint will darken the parts of the image that will be suppressed when the automatic cropping is applied.

6. Click on the Apply button in the lower toolbar.
Cropping

Cropping an image

The corrections done using the Distortion, Volume deformation, Perspective, and Horizon tools include an automatic crop feature that maximizes the visible field of the image. DxO ViewPoint’s Crop tool lets you adjust the proportions of the final image to suit your tastes.

Automatically cropping an image

After correcting the perspective of your image in DxO ViewPoint 3, go to the Crop palette and click on the Crop button. An adjustable grid will be superimposed on your image.

1. Click on the Auto button mode. In this mode, DxO ViewPoint 3 calculates the preserved zone of the image as closely as possible and displays darkened zones that correspond to the surface area that will be lost in the original image.
Checking/unchecking the Show grid box in the lower toolbar lets you activate/deactivate the composition grid in the image.

Auto mode calculates the crop as closely as possible.

Several formats are offered in the Aspect Ratio drop-down menu: 16/9 (TV format), 5/4, 5/2, 2/1, 3/2 (APS-C reflex and full-format cameras), 4/3 (compact camera format), and 1/1 (square format).

- By clicking on Preserve in the Aspect Ratio drop-down menu, you will preserve the proportions of the original image.
- By selecting Unconstrained, you can manually apply a correction.
- By selecting Add Custom, you can enter the pixel values (for height and width) of your choice and define the proportions of the custom crop.

2. Select the format you would like: the grid superimposed on your image will be automatically modified. By clicking on the grid, you can also change the position of the frame and adapt it to the composition of your image.
The grid can be resized and repositioned.

The crop grid is divided into thirds, making it easy to apply the “rule of thirds” when composing your final image.

Even though the crop is applied when you click on Apply, this can be undone so long as the image is not saved.

3. By checking the Constrain to image box, the frame is automatically confined to the part of the image being worked on so as to avoid having any dark zones superimposed on the perspective corrections.

4. To apply the crop, click on the Apply button in the lower toolbar.

5. Save your changes by clicking on File > Save As (or Save if you use DxO ViewPoint as a plugin).

Whether in automatic or manual mode, DxO ViewPoint 2 automatically detects the orientation of the crop zone.

Manually cropping an image

Click on the Crop button in the Crop palette. The adjustable grid will be superimposed on your image. To adjust the proportions of the final image to suit your tastes, select Freehand mode from the Correction drop-down menu.

Change the dimensions of the adjustable grid by manipulating the resizing points located in the corners and
on the sides of the grid. You can also change the overall position of the frame to adapt it to the composition of your image.

ℹ️ You can use the arrow keys on your keyboard to adjust the position of the crop zone.
About the miniature effect

The miniature effect tool simulates a tilt-shift lens, which moves the plane of sharpness in an image so as to give photos of landscapes or cityscapes the appearance of a scale model or diorama. This effect is particularly dramatic in urban landscape photos taken from above.

DxO ViewPoint 3’s miniature effect tool gives you great flexibility in choosing the positioning and the intensity of the focus areas.

Example of line placement for creating a miniature effect.
The result after applying the effect.
Miniature effect

Applying a miniature effect

After opening an image in DxO ViewPoint 3, go to the Miniature effect palette:

Among the settings within the Miniature effect palette is the shape of the blur to apply. The application will apply a circular blur by default:

Once activated, along with the selected (or default) blur shape, the Miniature effect superimposes a number of lines and tools on the image. These are, from top to bottom:
1. You can use the mouse to move the center anchor point in the image. By default, it is placed in the middle of the image, and is activated when the pointer passes over it.

2. The two continuous lines, one on each side, define the area of sharpness in the center on either side of the central anchor point. You can use the mouse to spread them further apart or to close them synchronously, or you can select one of the two lines (for movement in both directions), or select an anchor point (for movement in any direction and for rotation).

3. The small disk to the right of each reference line adjusts the blur intensity: Click to adjust the slider value with the mouse; the scale goes from 0 to 100 (the default value is 40).

4. The two dotted lines define the blur transition area between a solid line and a dotted line (the blur is maximal outside the dotted line). To adjust the size of the transition zone, just move one of the dotted lines toward the center (to reduce the transition area), or away from the center (to increase the transition area).

5. By default, the position of lines and blurring are symmetrical. If you want to set the blur to be on either side of the center mark, go into the Miniature effect palette, and uncheck Symmetrical position and / or Symmetric blur. This way you can move all the lines independently, as well as define two different blur intensity values.

6. When you are finished defining the miniature effect, click Apply in the bottom toolbar (or click Reset to cancel the effect).

7. After applying the effect, save changes to the image by clicking the Save As button in the top toolbar (standalone application), or click on Save in the bottom right (plugin mode).
To see the miniature effect unhindered by the lines, move the mouse out of the image.

To see the miniature effect unhindered by the lines, move the mouse out of the image.

For a broader view of the work area, use the mouse wheel to zoom out.

You can use the color-picker in the bottom toolbar to change the color of the effect lines.

The Blur shape menu lets you select different blur effects — for example, among effects which are more or less circular, or those that simulate the blur of a lens diaphragm with 6, 8, or 9 blades (the greater the number of blades, the more the blur / net transitions are smooth and progressive).

The differences among the available blur shapes.
Menus and preferences

Microsoft Windows standalone application and plugin versions:

- File: Open and Save images; quit from application.
- Edit: Undo/Redo commands and access to Preferences.
- Display: Enter full-screen mode, hide tool panes, and display/hide the superimposed composition grid.
- Help: Access to DxO online help, product activation, check for updates, and version information (“About”).

Mac OS X / Mac OS standalone application and plugin versions:

- DxO ViewPoint 3: Access to version information (“About”) and to preferences.
- File (standalone version): Open, Open Recent, Save, Save As, and Close commands.
- File (plugin version): Save command.
- Edit: Undo/Redo correction commands, and display/hide the superimposed composition grid.
- Display: Enter full-screen mode, hide tool panes, and display/hide the superimposed composition grid.
- Help: Access to DxO online help, DxO Academy tutorials, product activation, and check for updates.

In the standalone application version of DxO ViewPoint 3, the File > Save command overwrites the original file, and the File > Save As command creates a new file.

In the plugin versions, the Save button acts like the File > Save command (per above), and consequently all corrections overwrite the original file.

Preferences
The Preferences dialogue box lets you control a certain number of settings:

- **Language**: Change the program language (English, German, French, or Japanese).

- **Background color**: Change the shade of the gray background in the image display area. To return to the default shade, double-click on the slider.

- **Overlay grid size**: Adjust the size of the grid squares. To return to the default size, double-click on the slider.

- **Natural intensity**: Lets you change the Natural mode perspective correction intensity setting (default value: 75).

- **Show/hide image size**: Display the dimensions of the image in pixels underneath the main workspace window.

- **Automatically check for updates every 24h**: Self-explanatory; an additional Check now button lets you manually inquire about application updates (Internet connection required).

- **Product Improvement Program**: Choose to participate or cease to participate in this anonymous user feedback program designed to help perfect DxO ViewPoint 3.

- **Send crash reports**: Activate or deactivate automatic generation and sending of error reports following a program crash.
# Keyboard shortcuts

<table>
<thead>
<tr>
<th>Command</th>
<th>Windows</th>
<th>OS X</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fit display to screen</td>
<td>F3</td>
<td>Cmd + 0</td>
</tr>
<tr>
<td>Display at 100%</td>
<td>F4</td>
<td>Cmd + 1</td>
</tr>
<tr>
<td>Zoom in</td>
<td>Ctrl + +</td>
<td>Cmd + +</td>
</tr>
<tr>
<td>Zoom out</td>
<td>Ctrl + -</td>
<td>Cmd + -</td>
</tr>
<tr>
<td>Hand tool</td>
<td>H or spacebar</td>
<td>H or spacebar</td>
</tr>
<tr>
<td>Crop tool</td>
<td>C</td>
<td>C</td>
</tr>
<tr>
<td>Navigating between images</td>
<td>Right arrow</td>
<td>Left arrow</td>
</tr>
<tr>
<td>Rotate image left</td>
<td>Ctrl + L</td>
<td>Cmd + L</td>
</tr>
<tr>
<td>Rotate image right</td>
<td>Ctrl + R</td>
<td>Ctrl + R</td>
</tr>
<tr>
<td>Show/Hide superimposed grid</td>
<td>G</td>
<td>G</td>
</tr>
<tr>
<td>Move anchor points</td>
<td>Arrows</td>
<td>Arrows</td>
</tr>
<tr>
<td>Toggle between anchor points</td>
<td>Tab</td>
<td>Tab</td>
</tr>
<tr>
<td>Redefine the crop zone</td>
<td>Arrows</td>
<td>Arrows</td>
</tr>
<tr>
<td>Open</td>
<td>Ctrl + O</td>
<td>Cmd + O</td>
</tr>
<tr>
<td>Save as</td>
<td>Ctrl + S</td>
<td>Cmd + S</td>
</tr>
<tr>
<td>Quit</td>
<td>Alt + F4</td>
<td>Cmd + Q</td>
</tr>
<tr>
<td>Undo</td>
<td>Ctrl + Z</td>
<td>Cmd + Z</td>
</tr>
<tr>
<td>Redo</td>
<td>Ctrl + Y</td>
<td>Cmd + Shift + Z</td>
</tr>
<tr>
<td>Preferences</td>
<td>Ctrl + Shift + P</td>
<td>Cmd + ,</td>
</tr>
<tr>
<td>Show image before and after correction</td>
<td>Ctrl + D</td>
<td>Cmd + D</td>
</tr>
<tr>
<td>Full screen</td>
<td>F</td>
<td>F</td>
</tr>
<tr>
<td>Exit full screen mode</td>
<td>F or Esc</td>
<td>F or Esc</td>
</tr>
<tr>
<td>Show/Hide controls</td>
<td>F9</td>
<td>Tab</td>
</tr>
<tr>
<td>Online help</td>
<td>F1</td>
<td>Cmd + /</td>
</tr>
</tbody>
</table>
Slow mode for Perspective and Horizon tools

Press on Shift while placing anchor points on the image